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1.0 INTRODUCTION 

1.1  Quality Assurance Overview 

This Software Quality Assurance Plan (SQAP) provides the basis for MPSS software quality 
assurance. The plan itself is based on activities within a Precision Integration life-cycle model 
(i.c., software devclopinent and maintenance model) developed by Fluor Federal Services (FFS). 
The basis for this plan is information contained within the FDH proccdurc, HNF-PRO-309, 
Revision 0, “Computer Softwarc Quality Assurance Requirements”. 

Precision Intcgration (Figure 1) dcpcnds on several iterations (or cycles) of the following 
segments: 

Define (Kequiremcnts) 
Design 
Implement 
Tcst (Informal and Formal) 

. . . . . . . . . . . . . ..* ...... 

Figure 1 Precision Integration Cycles 
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The first cycle is referred to as the top cycle. The majority of development effort takes place in 
this iteration to avoid costly rework in future iterations. Each additional, cycle refines the 
software system, but allows for changes to all aspects (e.g., a requirement change). As cycles are 
performed, the time duration of each cycle becomes increasingly shorter, as does the number of 
problems related to testing exceptions. This$ in essence, meets an approved type of overall 
IEEE software lifecycle model, referred to as a “waterfall” type model. 

The key to this SQAP is that it creates a balance between oversight and staff productivity. The 
W-314 project has many Phases. Phase I of MPSS is construction of an MPSS Operator Trainer, 
with migration of this M P S S  system’s Human Machine Interface (HMI) and logic to several 
other tank farms, and a full mock-up test of the migrated MPSS in FYO1. Phase ll sees 
continued expansion and equipment configuration updates to the system. Therefore, this plan 
shall deal with activities, through Phase 11, which are entirely within the Precision Integration 
model shown in Figure 1,  and that allows for maintenance in future phases. 

The process shall include products for Define, DesigdImplement, and Test segments. In 
addition, where ever informal maintenance is no longer adequate, a formal configuration 
management plan shall be instituted for all changes to the system software. 

The configuration management shall include a method for releasing baseline versions of the 
MPSS, and reporting, fixing, and closing issues, enhancements and/or problems. Note that the 
MPSS Operator Trainer Modicon logic diagrams are currently configuration controlled within 
AutoCAD. A conversion to the RTP product line will occur to address safety class and general 
service designations through the MPSS. At that point, the converted drawings shall be controlled 
within RTP Net Arrays software, with version control provided by this plan. 

1.2 Scope 

This Software Quality Assurance Plan (SQAF’) provides the plan strategy and description of the 
tools used in performance of the Master Pump Shutdown System (MPSS) software development 
and maintenance. 

This document does not provide a description of the MPSS requirements. For more information 
related to the M P S S  requirements refer to HNF-SD-W3 14-PDS-004. 
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1.3 Acronyms and Definitions 

CATS: Computer Automated Testing System. A database application, or test engine, that takes 
specific test data tables and converts them into automatic and human interaction-based tests. The 
CATS gathers all test responses, comments, and compares results to generate sets of passing and 
exception reports. 

ECN: Engineering Change Notice 

EDT: Engineering Data Transmittal 

FDH: Fluor Daniel Hanford 

FFS: Fluor Federal Services 

HMI Software: A Human-Machine Interface software package developed by Ci Technologies, 
Citect, is used to create the human-machine interface portion of the DAS. The PC-based package 
works within the Microsoft Windows NT environment to provide graphic displays with user- 
friendly controls. 

IF': In Progress 

M P S S :  Master Pump Shutdown System. Operator HMI for setting up and verifying waste 
transfer routes from tank to tank (up to six simulatneous). Also has interlocks connected to leak 
detection devices to ensure orderly shutdown of affected transfer lines. 

PC: Personal computer used with HMI software to provide the human-machine interface. 

PDS: Project Development Specification 

PE: Professional Engineer certification from the State of Washington. 

PLC: The Programmable Logic Controller is the microprocessor-based industrial controller 
capable of real-time control. It provides all of the discrete and process control logic required for 
controlling and/or monitoring the process. Once the program has been loaded into the controller 
module, it will execute all control/monitoring functions even if connection to the HMI computer 
is severed or interrupted. 

PM: Project Manager 

QTP: Qualification Test Procedure 

RCR: Review Comment Record 
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Real-time: Indicates that monitoring and control signals are being processed and implemented in 
an acceptable time kame which is usually after an imperceptible time delay after the actual 
process events. 

W P :  River Protection Project 

SIMCart: Simulator Cart. When used with CATS, SIMCart provides a method for emulating all 
applicable field I/O virtually so as to fully test a finished system's HMI and PLC. 

SQAP: Software Quality Assurance Plan. A method utilized to assure quality performance of 
software development. 

V&V: Verification and validation. Process of ensuring that software products and/or systems 
are reviewed and checkeutested throughly at the different stages of implementation in the 
lifecycle model. 

2.0 SQAP PROCESS 

This section describes the tools available, and how and when to apply these tools. The process is 
primarily document and form based. The following are the tools that shall be described. 

t Appendix A Precision Integration Products Checklist 
t Appendix B Development Personnel Requirements 
t Appendix C MPSS Development Staff Personnel Profile Form 
t Appendix D Configuration Management Plan Including SCR & Testing Evaluation 

Process 
t Appendix E Configuration Control-Software Release Process 

2.1 Precision Integration Products Checklist 

In Appendix A is the primary tool--a checklist that shows the different Precision Integration 
Iteration Segment products generated for the MPSS. The Appendix A checklist is used to assure 
that when an iteration segment (i.e., define, design, implement, test) is entered, the effect of the 
system change or implementation is fully evaluated, and the products are generated or modified 
with appropriate V&V. This will ensure that 1) the effect of a change to the system is evaluated 
before the change is made, and 2) the system documentation reflects the current state of the 
system after a change is implemented. This checklist is to be reviewed 1)  during implementation 
of the initial system and 2) for SCR/F'R(s) implementation during system upgrades and 
maintenance. 
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2.2 MPSS Development Staff Personnel Requirements 

This list in Appendix B provides staffing requirements for the MPSS Software Development 
Personnel. The form is Appendix C shall be filled out for each person and kept in a desk 
reference by the MPSS PM. 

2.3 Configuration Management 

There are two procedures, in Appendix D and E, that account for M P S S  developed software 
configuration management and releases respectively. 

3.0 REFERENCES 

1) HNF INFORMATION RESOURCE MANAGEMENT PROCEDURES 

HNF-PRO-309, Computer Software Quality Assurance Requirements, Revision 1 

HNF-PRO-2778, IRM Application Software System Life Cycle Standards, Revision 0 

2) HNF ENGINEERING PROGRAM 

HNF-PRO-244, Engineering Data Transmittal Requirements 

HNF-PRO-440, Engineering Document Change Control Requirements 
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APPENDIX B DEVELOPMENT PERSONNEL POSITION REQUIREMENTS 

All persons filling the below positions on the Project W-314 MPSS development must be 
certified by the MPSS Project Engineer or Manager to meet the listed qualifications for the 
position. The certification is to be documented on the form in Appendix C. If the position 
required is not listed below, please contact the MPSS PM. 

PROJECT MANAGEWENGINEERLEADS: 

1) A degree in engineering or a Washington State Professional Engineering License. 
2) 2 years project management experience. 
3) Current with FFS procedure training per the EMPORTS reading list. 

PLC PROGRAMMERS: 

1) 2 years of engineering trainindexperience related to control systems. 
2) Knowledge of ladder and function block logic (Note: a junior programmer with less than two years 
experience can work under the guidance of a qualified programmer). 
3) Current with FFS procedure training per the EMPORTS reading list. 

HMI PROGRAMMERS: 

1) 2 years experience developing human machine interface screens with Citect or equivalent HMI 
development tool (Note: a junior programmer with less than two years experience can work under the 
guidance of a qualified programmer). 
2) Current with FFS procedure training per the EMPORTS reading list. 

DATABASE PROGRAMMERS: 

1) 2 years experience developing relational databases using Microsoft Access or equivalent database 
software (Note: a junior programmer with less than two years experience can work under the guidance of a 
qualified programmer). 
2) Current with FFS procedure training per the EMPORTS reading list. 

LOGIC REVIEWERS: 

1)  Washington State Professional Engineering License in either Control Systems or Electrical engineering. 
2) Current with FFS procedure training per the EMPORTS reading list. 

INTEGRATION TESTERS: 

1) A degree in engineering or background in a technical field. 
2) Current with FFS procedure training per the EMPORTS reading list. 

HMI TESTERS: 

1) A degree in engineering or background in a technical field. 
2) The ability to effectively operate a PC using Microsoft Windows and Office Programs 
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APPENDIX C MPSS DEVELOPMENT STAFF PERSONNEL PROFILE FORM 

Project W-314 MPSS 
Personnel Profile Form 

Name (First MI Last): 

Position Title (See Appendix B of MPSS SQAI-more than one title may be submitted for 
multi-tasking personnel): 

Note: If a reviewer, ensure that the person is independent of the work being inspected, unless 

Position-Related Qualifying Education, Certification, and Experience: 

If deficient for position requirements, mark here 

If marked, but personnel is to be used on a task-state action plan, completion date, and 
mentoring position engineer below: 

Reviewed by: (Print and Sign Name and Date) 
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APPENDIX D CONFIGURATION MANAGEMENT PLAN INCLUDING SCR PROCESS 

Configuration Management Plan For Master Pump Shutdown System (MPSS) 
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6.0 RECORDS COLLECTION AND RETENTION 
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9.0 MPSS S C W R  TESTING EVALUATION FORM 
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1 .O INTRODUCTION 

1.1 PURPOSE 

This Configuration Management Plan (CMP) provides the instructions for change & version 
control of the Master Pump Shutdown System ( M P S S )  software. 

1.2 SCOPE 

This plan applies to the MPS system software to be used by CH2MHILL (CHG) and includes the 
computer s o h a r e  source and executable code. This also applies to special configurations of 
vendor software (e.g., Windows NT 4.0, etc.). Control of information produced by the software 
once it has been exported is the responsibility of the receiving organization. This plan is required 
for formal 1) development and 2) production release and system maintenance. Changes to design 
basis documentation, via ECN, will require following this CMP to evaluate MPSS impacts. 

1.3 OVERVIEW 

The primary purpose of the M P S S  is to provide an automated approach (via PLC & an HMI) to 
the safe and orderly shutdown of waste transfers in case of leak detection. 

1.4 DEFINITIONS 

Production: Pertaining to the status of a given system following acceptance by the customer. 

Software Change Request and Problem Report (SCWR): A document that identifies a proposed 
change to or suspected problem with the WCS hardware andor software. An SCRiPR may 
identify a new function, modify an existing function or report suspected problems of the 
software. 

System and Software Configuration Management (SCM): A set of management disciplines 
within the context of the software engineering process that applies technical and administrative 
direction and surveillance. It identifies and documents the functional and physical characteristics 
of a product, controls changes to those characteristics, and it records and reports the change 
processing and implementation. 

SCRPR Testing Evaluation Form: A document that allows an SCR/PR(s) to have testing 
analysis performed to identify appropriate test cases to be be planned. The test cases are then 
attached to this form, approved by the change control board, and the tests performed to close out 
the SCR/PR process. 
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2.0 MANAGEMENT 

2.1 ORGANIZATION 

CH2MHILL Hanford (CHG)--shall be designated as MPSS system owner, operator and 
maintenance authority. 

Fluor Federal Services (FFS)--shall be designated MPSS developer, maintainer and custodian in 
conjunction with CH2MHILL Hanford. 
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2.3 IMPLEMENTATION 

This CMP becomes effective whenever a problem or change request is identified, either 
internally (prior to release to CH2MHILL Hanford for Production) or externally. Overall 
responsibility for the SCM activity rests with the Lead Engineer described in Section 2.2. 
Version change control of source code and executables becomes effective when released for 
correction of SCR groups, testing for major revisions, andor released for production on minor 
revisions. 

2.4 POLICIES AND PROCEDURES 

Configuration management of the M P S S  software items will be in guidance from “F-PRO- 
309, particularly with regards to Software Control, Change Request & Problem Reports, and 
Document Approvals. 

3.0 SOFTWARE CONFIGURATION MANAGEMENT ACTIVITIES 

Configuration Management will be applied to the MPSS software items per the requirements 
established and steps provided herein. 

3.1 CONFIGURATION IDENTIFICATION 

3.1.1 Application Software 

Design basis documentation which sets the foundation for the configuration of the MPSS 
software is found in the PDS associated references. 

The local HMI which displays messages, alarms, and information to the operator are via Personal 
Computers with Windows NT O/S and using Citect as the Human Machine Interface (HMI). 
The HMI is used for all monitoring and initiation of control. 

Each production for HMI software releases shall be a grouping of the code and executable 
software products, and any modifications to vendor software (e.g., configurations, etc.). The 
release is assigned a unique release number by the M P S S  System and Software Custodian. 

The software release number is of the form R.r as described in HNF-PRO-464, Software Control. 
Please refer to the sample form in the “Release Cover Sheet and Revision Record”, Appendix E. 

If the R is absent, the MPSS software is still in the Development phase, 

3.1.2 Software Products 

Each software product (e.g., the application software development packages, the operating 
system software, the network communications software, etc.) is assigned a unique product name 
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and release version number by the appropriate vendor and will be used as identification as much 
as practical on the software release documentation. 

3.1.3 Computer Hardware 

Computer hardware, such as installed field PLCs is controlled by normal Hanford administrative 
procedures (e.g., H-2 drawing system via Engineering Data Transmittals (EDT) and Engineering 
Change Notices (ECN)), Ref. 2. Configuration control is required by the MPSS, only for the 
cases of 1) identification of the minimum equipment necessary for operation and 2) evaluation of 
MPSS local and remote HMI and/or PLC impact, caused by field hardware changes that are part 
of the design basis documentation set--via an SCRPR. 

3.1.4 Documentation 

Each MF'SS document is assigned a unique name, number, and revision in accordance with the 
J3NFBPP documentation procedures and is documented. 

MPSS SCR/PR forms shall be kept in local project files in log form by the Lead Engineer. When 
a Release of the MPSS system occurs, the Lead Engineer will ensure that the Release information 
is completed and associated SCRPRs are updated. 

MPSS S C W R  testing evaluation forms shall be kept in local project files in log form by the 
Lead Engineer. When a Release of the MPSS system occurs, the Lead Engineer will ensure that 
the Release information is completed and associated testing evaluation forms are updated. 

3.1.5 Application Reports 

Control of application reports generated by the MPSS is not provided under this CMP, and is the 
responsibility of the software user organizations. 

3.1.6 Removable Media Labels 

Removable media shall be labeled consistent with the following information on the label: 

Software identification 

Recording date and time. 

Media identifier (i.e., disc number) 

Software revision identification ("R.r", "R" =major and "r" =minor software 
changes, e.g. 1.0) 
Software or data name or description 
Responsible organization and software custodian's name 
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3.1.7 Directory Nomenclature 

Original or backup source and executable softwarc placed on media containing multiplc 
versions/revisions shall bc segregated using the available directory/ subdirectory structure. 

A major directory shall be provided Tor the software product, labeled with the product 
mnemonic. Subdirectories shall be provided for each major revision. Each minor revision shall 
be contained in a separatc sub-subdirectory, uniqucly identified with the appropriate revision 
numbcr. The subdirectory name shall contain the ma.jor and minor rcvision numbcr, separated by 
a period. For example: 

APO I2/FDNWPROJ/PROJECTS/W-3 14/RELEASEO,X<release date> 

A sample dircctory listing is shown: 
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3.2 CONFIGURATION CONTROL 

SCRPR approvals are recorded and submitted using the SCRPR form. 

E-mail approvals for processing SCR/PRs may be substituted for handwritten approvals. When 
e-mail approvals are used a copy of the e-mail approval must be attached to the SCRPR. 

Telephone approvals for processing SCR/PRs may be used, but subsequently, must be 
documented on the SCRPR form or with an e-mail approval. 

S C W R  testing evaluation form approvals are recorded and submitted using the testing 
evaluation form, or electronic equivalent (e-mail approval okay). 

3.3 CONFIGURATION STATUS ACCOUNTING 

The configuration status of all controlled items is documented in Release information per 
Appendix E of the MPSS SQAP. In addition, the status of all SCRPRs, testing evaluation 
forms, and associated releases will be maintained and is available !?om the Lead Engineer. 

3.4 AUDITS AND REVIEWS 

The MPSS and associated documentation, including software change control, will be available 
for audit during normal working hours. The MPSS System and Software Administrator should 
periodically audit the project file and change control documentation to ensure compliance. Other 
surveillance and audits are the responsibility of other outside organizations and are outside the 
scope of this plan. 

All changes and tests shall be reviewed (verified) by an independent technical person. For minor 
changes and releases, test results may be attached to the SCRPR. For major changes and 
releases, refer to Testing Evaluation Form log. 

Should changes require major modifications or enhancements, the Lead Engineer, Software 
Engineer, and Design Authority will determine if a formal plan will be prepared. The formal 
plan will identify appropriate technical, V&V and QA reviews consistent with HNF procedures 
and commensurate with the complexity of the change. 

3.5 ACCESS CONTROL 

Access control for operation of the MPSS software is administrative. However, to make changes 
to the MPSS code requires software other than what is available to the user through the local or 
remote HMI. 
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3.6 BACKUP AND RECOVERY 

Backup shall be from the most recent set of release files per Section 3.1.7. 

Backup of the source code and executable files that constitute each product release is done by the 
software custodian onto the fileserver backup partition selected and documented by the Software 
Custodian--for example “\\DCH\PROJECTS\WCS\SCMP\” (see section 3.2.1) at the time of 
release. The Software Custodian is responsible for verifjmg that the backup is in place and the 
appropriate files exist. 

Recovery shall be accomplished by rewriting the appropriate files from the master media onto the 
production fileserver or its replacement. This shall be accomplished by the System and Software 
Custodian or Lead Engineer\Software Engineer as needed. Should the master media be 
simultaneously corrupt, recovery shall be from the backup fileserver partition. 

4.0 TOOLS, TECHNIQUES AND METHODOLOGIES 

Tools and instructions for software administration and usage are contained in Ref. 1. 

All MPSS software release modifications will be completed and certified in a test environment 
where possible. Tests are informal up to the point of the QTP. At this point, rigorous testing 
methods shall be utilized to test the M P S S .  This includes a testing evaluation for each SCR/PR 

All MPSS software modificationdenhancements will be completed and certified in a test 
environment where possible. These changes will be implemented into the production 
environment only after the Design Authority has reviewed and approved the test results and the 
Change Control Board has approved the implementation. Modifications and enhancements will 
be grouped logically into production releases. 

5.0 SUPPLIER CONTROL 

The System and Software Developer & Maintainer will ensure that new releases and installation 
of the vendor application and software product are tested prior to its being placed in production. 
Changes in vendor application andor software product will be processed as a change request or 
problem report with the same approval requirements as a locally generated change. 

The System and Software Developer & Maintainer will maintain a software project file or binder 
of all system and software-related project documentation, correspondence, and project produced 
documents. This may be in the form of reference to released (e.g., HNF) documentation. Vendor 
provided materials and manuals will be maintained by the System and Software Custodian. This 
software project file or binder will maintain the most current version of all documents for the life 
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of MPSS. 

6.0 RECORDS COLLECTION AND RETENTION 

The M P S S  System and Software Developer and Maintainer will process software development 
and maintenance records in accordance with HNF-PRO-309. These records, include at a 
minimum the SCRiPR log book and S C W R  form entries, the Testing Evaluation log book and 
Testing Evaluation form entries, and will be kept by the Lead Engineer in local project files 
andor logbooks. 
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7.0 REFERENCES 

1) 

HNF-PRO-433, Small Job Development, 
HNF-PRO-555, System Configuration Management Plan, 
HNF-PRO-464, Software Control 
HNF-PRO-564, Records Retention and Disposal. 

2) HNF ENGINEERNG PROGRAM 
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HNF-PRO-244, Engineering Data Transmittal Requirements 
HNF-PRO-440, Engineering Document Change Control Requirements 
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8.0 MPSS SYSTEM AND SOFTWARE CHANGE REQUEST AND PROBLEM REPORT FORM 
II 

MPSS SYSTEM AND SOFTWARE CHANGE REQUEST OF; 

NOTE: Submitter Fills In Parts 1-8 (NON-GRAY) 

1. 

2. Submitted By: 

3. Project Name: 

4. Areas Affected (check): 

SCR/PR Type: [ ] Problem [ ] Enhancement 

1 PLC [ 1 HMI 

[ I  Database [ 1 Operating System 

5. Submitter's Priority [ 1 
(1= Critical 2= Vcly Important 3= Important 4= Inconvenient 5= Interesting) 

7. TaskiChangelProblem Title (one sentence Description): 

'ROBLEM REPORT (SCRIPR) 

FOR FFS USE ONLY 

SCR Number: 

w10: 

Current 
VerlRev: 

(check when complete) 

6.  Requested 
Completion Date: 

Decision By: 

Assigned To: 

Resolution: 

I I Accept I 1  Modify [ 1 Relect [ 1 Defer 

Target Release Date: 

System and Software Programs, Modules or Files Affected 

Task Completed By: 

Verified By: 

Actual Release Version: 

Closed By: 

Date: 

Date: 

Date: 

Date: 
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These instructions are for preparing the Change Request or Problem Report. If more space is needed, use blank 
pages and attach to the SCFUPR form. This will be the record of the change request or problem report. 

Submitter (Anyone In MPSS Organization may submit) : 

1.  

2. 

3. 

4. 

5.  

Lead Engineer: 

1.  

2. 

3. Enter the date received. 

Fill out Sections 1-8 of the form-DO NOT fill in gray areas. 

Suggestions for SCR resolution may be put into the Detailed Description section. 

Provide a description of the changes requested or the problems being reported. 

Attach additional sheets if necessary. 

An E-mail to start the process is acceptable as log as an SCR form is filled out and logged. 

On receipt, enter into the MPSS SCFUPR Log. Enter the next SCR number on the form. 

Track information by entering into the SCR database. 

4. 

5.  

Enter current VersionRevision of the product. 

Evaluate SCFUPR or group of SCFUPRs against Appendix A of this SQAP. Check when complete, and 
ensure activities are completed. 

Review change request or problem with development personnel. 

Note that SCFUPR may require attached cost estimate and planning by the Lead Engineer if extensive 
change or testing are anticipated. 

6. 

7. 
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Log ID # : Summary Information Table 

1. Submitted Bv: I 

Decision By Change Control Board ChaidDesignee: 

2. Date: I 

[ ]Accept [ ] Modify [ ] Reject [ ] Defer 

~ 

3. Current Release. 

4. Describe Overall Impact to MPSS System from SCR Changes (document for each SCR): 

5. Check the Box Indicating Analysis to be performed for each SCR(s)- 
List SCR(s)/or ALL: 
[ ] Perform Design Analysis and Impacts Review (attach review) 

[ ] Perform Automated Cicode andlor Object Cross-Reference (attach results) 

[ ] Perform Automated SyntadSpelling Check (attach results) 

[ ] Perform Other (specify and attach results) 

Areas Affected (check): 

SCR/PR(s): 

SCR/PR(s): 

SCR/PR(s): 

SCR/PR(s): 

[ I  PLC [ ] HMI [ ] Database [ ] Operating System 

7.  Overall Test Approach Justification Summary for items in 6: 

6. Testing 
[ ] SCR/PR(s) test cases 

(attach w/ results) 

[ ] QTPtest 

[ ] ATPtest 

[ ] OTPtest 

Reference Number: 

(Provide Review Copy) 

FOR MPSS CCB USE ONLY: SCR Resolut.ion Information 

Assigned To: FFS I Target Release Date: I - 

Reasons (If Modify, Reject or Defer-attach additional sheets as required) : 

Task Completed By: FFS 11 Date: 

Verified Bv Chair/Designee: 11 Date: I 
Actual Release Version: 11 Date: I 
Closed Bv ChaidDesianee: 11 Date: I 

Thcsc instructions are for preparing the SCR/PR Tcsting Evaluation Form. If more space i s  needed, use blank 
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pages. This will be the record of the testing evaluation for the SCRRR. 

Submitter (Software Engineer) : 

1. 

2. 

3. 

4. 

Lead Engineer: 

1 .  

Fill out Sections 1-7 of the forn-DO NOT fill in gray areas. 

Suggestions for SCR resolution may be put into the Detailed Description section. 

Provide a description of the testing, including analysis and SCR/PRs affected. 

Attach additional sheets if necessary. 

On receipt, enter into the MPSS SCRlPR Testing Evaluation Form Log. Enter the next SCRPR Testing 
Evaluation Log ID # onto the form. 

Forward, when appropriate, for review by the Change Control Board (CCB) Chair for action. 

Receive, when completed by CCB, and assign for testing per form. 

Forward, when testing is complete, to CCB for verification and closure. 

2. 

3. 

4. 

Change Control Board Chairman: 

1.  Receive form for review and accept, modify, reject or defer on form. Give reason. Return to Lead 
Engineer for action. 

Receive, when completed by Lead Engineer, test results for accepted forms. 

Verify and take actions to close Testing Evaluation Form and send to Lead Engineer. 

2. 

3. 
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APPENDIX E CONFIGURATION CONTROLSOFTWARE RELEASE PROCESS 

Process for Internal Software Release(s) 

For an Internal release of Software within a FFS Project, Teams should follow the described 
process where applicable. This process needs to be an iterative function, as an example - leaving 
testing (other than the standard review of ones own work) to the end invites unnecessary risk and 
delays to timetables. 

The Project Team shall maintain two versions of the current release. One version will be a 
developmental version that will be in a continued state of flux as developers add enhancements 
and correct defects to the application, the other will be a testing platform that will remain stable 
allowing testers a static plane from which to work. 

Release Review/Assign 

ORIGINATE 

Generate Software Change Request (SCRK'R) per SCMP (e-mail as temporary SCR 
okay). 

REVIEW/ASSIGN 

LE Determine(s) whether SCRK'R is a defect or an enhancement 
A. Prioritize accordingly (typically a bug fix will have a higher priority & an 

enhancement will be accompanied with a charge code) 
B. SCRK'R meetings shall be held as required to document priority of SCRPR open list. 

TEST 

Focus on achieving the following before closing an SCRK'R. 
Reliability: fix operates without crashing, hanging, causing exceptions, or 
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leaking resources 
Functionality: fix addresses the problem & meets established PDS requirements 
Application Performance: The application responds in a timely manner 
System Performance: The application continues to perform as designed when it 
is subjected to production load. For every instance where the application does not 
meet expectations an SCRPR is generated or the current S C W R  is updated. 

RELEASE 

The Project Team will maintain two versions of the current release 
Development Version (dynamic) 
Testing Version (static) 
Approval 

Based on SCR/PR(s) successful testing completion. The development 
team issues a new release. This release, once reviewed by Project 
Management, will replace the existing release. 
Use the Release form to document the release. 

Replaces current Development/Testing versions of existing release 

Saved within the project directory 

New Release 

Old Release 

Current MPSS Release Procedure (Development-FY00 and 
FYO1) 

Purpose: Describe the Release Process used to release a version from MICRON2 (Devel Server) 
to MICRON3 as a test server and MICRON4 as a test client. 

Note: 
The structure of the project is: 

Main Project = MPSS 
Sub Projects = CBS, TR, WTA 

The version number x will be used for all projects. 
Right now, the "designated backup media" is an empty J a z  disk - all W314 workstations have a 
Jaz drive. 

Applications used for Release: 
Windows NT Explorer 
Citect Explorer 
Citect Project Editor 

1 .  Devel Server(MICRON2): Backup the development version and move to the designated 
backup media, using the next release number in the filename (<project name>-rOx.CTZ). 



Software Quality Assurance Plan for MPSS RPP-6764 
Revision 0 

Page 3 1 

Make sure to choose "compression" and "save subdirectories". 
a. Citect Explorer -> Tools ->Backup 

b. Backup each of the 4 projects: MPSS, CBS, TR, WTA 

c. Backup Project MPSS 
check: Compression 
check: Save Subdirectories 
File name: MPSS-rOx.CTZ 

d. Backup Project CBS 
check: Compression 
check: Save Subdirectories 
File name: CBS-rOx.CT2 

e. Backup Project TR 
check: Compression 
check: Save Subdirectories 
File name: TR-rOx.CTZ 

e. Backup Project WTA 
check: Compression 
check: Save Subdirectories 
File name: WTA-rOx.CTZ 

f. Move the backup files to Jaz drive. 

2. Test Server(MICRON3): Restore the backups to a new project on the test server computer 
(MICRON3) 
a. Citect Explorer -> Tools -> Restore 

b. Restore the subprojects before restoring the main project. 

c. Restore Project WTA 
Restore from: Jaz drive 
To: New Project 
Name: WTA-rOx.ctz 
Location: C:\citect\user 

d. Restore Project Trainer 
Restore ftom: Jaz drive 
To: New Project 
Name: TR-rOx.ctz 
Location: C:\citect\user 
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e. Restore Project CBS 
Restore from: Jaz drive 
To: New Project 
Name: CBS-rOx.ctz 
Location: C:\citect\user 

f. Restore Project M P S S  
Restore from: Jaz drive 
To: New Project 
Name: mpss-rOx.ctz 
Location: C:\citect\user 

3. Server(MICRON3): Copy files from 'c:\citect\userhpss-rOxEles\test comms' into 
'c:\citect\userhpss-rOx'. Replace all existing files. 

4. Pack the files. 
a. Citect Project Editor -> File -> Pack 

5. Server(MICRON3): Compile the project 
a. Citect Project Editor 
b. Select Project MPSS 
c. File -> Compile 

6. Server(MICRON3): Windows NT Explorer 
On the test server computer, go to the "Files" subdirectory of the project directory created in Step 
2. Copy the file MPSS.MDB to C:\CitectData. 

7. Server(MICRON3): On Test Server Computer, change the computer set up in Citect Explorer. 
a. Citect Explorer -> Tools -> Computer Setup 
b. Citect Computer Setup Wizard 

Express setup 
c. Computer Role Setup 

Server and Display Client 
d. Project Setup 

Project Name: mpss-rOx 
e. I/O Server Setup 

check: This computer is an I/O Server 
I/O Server Name: <default> 

uncheck: This computer is an Internet Server 

check: This computer is an Alarm Server 
option: Primary Alarm Server 

f. Internet Server Setup 

g. Alarms Setup 
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h. Reports Setup 
check: This computer is a Reports Server 
option: Primary Reports Server 

check: This computer is a Trends Server 
uncheck: Trends Server supports redundancy 

j. Alarms, Reports and Trends Server Setup 
This Server Name: MICRON3 
Other Server Name: (blank) 

Citect computer name: MICRON3 

i. Trends Setup 

k. Network Setup 

8. Server(MICRON3): Verify ODBC DSN. 
a. Control Panel -> ODBC Datasources ->User DSN tab 

Select w314 
Click Configure button 

Data Source Name: w314 
Database: C:\citect\data\mpss.mdb 

b. ODBC Microsof? Access Setup 

If not, then change using Select button. 

9. Client(MICRON4): 

Add project links to the directory created in Step 2 for each project. 
\\micron3\croot\citect\user\mpss~rOx). 
\\micron3\croot\citect\user\CBS~rOx). 
\\micron3\croot\citect\user\TR~rOx). 
\\micron3\croot\citect\user\WTA~rOx). 

a. Citect Explorer -> File -> Add Project Link 

10. Client(MICRON4): Change the computer set up in Citect Explorer. 
a. Citect Explorer -> Tools -> Computer Setup 
b. Citect Computer Setup Wizard 

Express setup 
c. Computer Role Setup 

Display Client 
d. Project Setup 

Project Name: mpss-rOx 
e. Alarms, Reports and Trends Server Setup 

Primary Server Name: MICRON3 
Standby Server Name: (blank) 

Citect computer name: MICRON4 
f. Network Setup 
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11. Client(MICRON4): Verify ODBC DSN. 
a. Control Panel -> ODBC Datasources ->User DSN tab 

Select w314 
Click Configure button 

Database: I:\citect\datahpss.mdb 
If not, then change using Select button. 

b. Verify that 

CURRENT RELEASE DOCUMENTATION 

At a minimum, the release documentation shall include the release title, the release date, 
comments about the release including why the release is being made, and the files contained in 
the release directory. Refer to the form at the end of this Appendix (E) that shall be filled out for 
each release. 

This documentation shall also be put electronically in the MPSS.CTZ file of the release directory. 
To retrieve the information, restore the project and access the file within 
‘‘Citect\UserMPSS\[Release Number]\FilesRelease Notes.txt. The following is an example 
shows typical release notes: 

Project W-314, MPSS Release Notes: 

Release 0.7 - March 9,2000 

Added SFV Functionality, preliminary fix of communication losses to PLC, added association to 
CBS, cleared several SCRs since Rev 0.4 of MPSS. Revisions 0.5 and 0.6 fixed SCRs, though 
no 
real additions were part of each release. 
All released subprojects as Rev 07. 

Contained files: 

_~___-____-  _ _ _ - ~ -  ______ 

mpss-rO7.ctz 
cbs-rO7.ctz 
tr-rO7.ctz 
wta-rO7.ctz 

Release 0.4 

SCRs still open: 101, 108, 114, & 115 
Added floor drains, solid red on objects for acknowledged alarms, compressed libraries, began 
removing references to QueryArg table in mpss.mdb. 
All released subprojects as Rev 04. 



Software Quality Assurance Plan for MPSS RPP-6764 
Revision 0 

Page 35 

Contained files: 
mpss-rO4.ctz 
cbs-rO4.ctz 
tr-rO4.ctz 
wta-rO4.ctz 

Release 0.3 

SCRsstillopen: 89, 101,108,113,114,115,& 125 
Included project tree with Trainer, Create by Segment and Waste Transfer Annunciator 
subprojects. 
All released subprojects as Rev 03. 

Contained files: 
mpss-rO3.ctz 
cbs-rO3.ctz 
tr-rO3.ctz 
wta-rO3.ctz 

Release 0.2 

Included project tree with Trainer, Create by Segment and Waste Transfer Annunciator 
subprojects. 
All released subprojects as Rev 01. 

Contained files: 
mpss-rO2.ctz 
cbs-rO2.ctz 
tr-rO2.ctz 
Wta-rO2.ctz 

Release 0.1 
Original release of project W-314, Master Pump Shutdown System 
Contained files: mpss-r0l .ctz 
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Date: 

MPSS RELEASE FORM 

At a minimum. the rcleilsc docurncntation shall  include the rclcdsc title, the rc lwsc  date, cornrncnts about thc relcasc !nduding why thc rcl~ilse IS 

k i n g  made, and the files conwined in the relcilsc dirccrory. 

L O U I D # :  I MPSS Release Form 

resting Evaluation Form Log ID# (attach sheet): 

1. Release Title: 

2. Release Date: 

3 .  Release Version (Ensure Back-UD of Previous Release): 

1. Release Comments: 

- 
3. Check Categories Included and List Files Contained in Release: 

[ ] PLC Logic: 

[ ] HMI: 

[ ] Database: 

[ ] Operating System: 

FOR MPSS CCB USE ONLY: Release Information 

3osed By FFS: (1 Date: 
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